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Adobe Photoshop Album& Jasc Photo Album
by Geoff Walker

re digital photos piling up on your hard
disk and on CDs? Do you have trouble
retrieving a specific photo from the
morass? Do you wish you had a simple way to edit and
print photos? Have you ever wanted to easily create a
slide show on a CD that could be played on any livingroom DVD player? If any of these questions strike a
nerve, you need digital photo album software. Two
major players in digital photography software (Adobe
and Jasc) have just released new offerings in this category, and this article compares them in detail.

A

Predecessors and companions
Adobe’s Photoshop Album (v1.0) is a brand-new program, not directly based on any previous Adobe product. With this release, Adobe’s digital photography programs can be classified into three tiers:
✘ PHOTOSHOP (V7.0) – digital image
manipulation tools for professionals
✘ PHOTOSHOP ELEMENTS (V2.0) – digital image
manipulation tools for amateur photographers
and photo enthusiasts (hobbyists)
✘ PHOTOSHOP ALBUM (V1.0) – organizing,
enhancing and sharing tools for “active picture
takers” (consumers)
You may have seen Adobe’s Photoshop LE (limited edition) or PhotoDeluxe in the past. These discontinued products were both predecessors to Photoshop
Elements. LE was an OEM-only product created by
removing the production-oriented features from
Photoshop, which still left it still too complex for the
midrange user. PhotoDeluxe was a severely dumbeddown image editing program for the home user; it also
included templates and guided activities for image-oriented projects such as calendars. Neither program fully
addressed the “organizing, enhancing and sharing”
needs of the digital image user, and neither program
was particularly successful.
Jasc’s Paint Shop Photo Album (v4.0) is the
renamed and upgraded next generation of Jasc’s After
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Shot. (After Shot was in turn previously known as Image
Expert.) Jasc is best known for PaintShop Pro (v7.0),
which is directly competitive with Adobe’s Photoshop
Elements. (PaintShop Pro v8.0 is currently in public
beta.) Jasc doesn’t have a professional-level program
equivalent to Photoshop, which stands alone as the
“gold standard” in image editing.

Getting started
For the remainder of this article, the two programs are
referred to as “Adobe” and “Jasc”, rather than “Adobe
Photoshop Album” and “Jasc PaintShop Photo Album”.
As intimated above, both programs are aimed at the millions of digital camera owners who need software to
“organize, enhance and share” their ever-growing
stacks of digital photos. These are both entry-level programs; they don’t require any previous familiarity with
digital image management. The feature comparison
table is the heart of this article; you should probably
study it before you read the rest of the text. From this
point on, the rest of the article is a detailed comparison
of the two programs.

Basic screen layout
Both Adobe and Jasc display thumbnails in the middle
of the screen. Adobe has a collapsible panel on the left
for keywords/tags, and a collapsible panel on the right
for image information (properties). Generally, you want
both of these panels displayed all the time, so the
screen layout remains relatively constant as you use
the program.
Jasc has a single, multi-function, collapsible
panel on the left with four or five tabs (depending on the
mode you’re in). The tabs are as follows:
✘ Browse, for displaying the PC’s directory tree
and selecting which Albums (folders) to open
✘ Info, for displaying image information and
some metadata (e.g., camera settings)
✘ Keywords, to apply keywords/tags to images
✘ Search, for finding images
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✘ Album, for displaying thumbnails in the left
panel when in Image View mode
Because the panel is multi-function, I tended to
constantly switch between Browse, Info and Keywords
as I worked on images. This layout is substantially less
convenient than Adobe’s two-panel layout.

Photo Well vs Album
At first glance, the basic user interface of Adobe and
Jasc seem very similar – they both display thumbnails.
Adobe calls the screen where the thumbnails are displayed the “Photo Well”; Jasc calls it the “Album”.
However, there is a fundamental difference. There is
only one Photo Well; whatever thumbnails are displayed
are the result of a search or a command such as Show
All. The user doesn’t need to be aware of the physical
location of the image files. In fact, only the image date
and time is displayed for each thumbnail. To see the file
and folder name for an image, you have to select the
thumbnail and look in an information panel on the right
side of the screen.
In Jasc, multiple Albums are often displayed. Each
Album represents the content of a single folder (the
folder name is at the top of the Album). You open
Albums by browsing the directory tree that appears
when you click on the Browse tab on the left side of the
screen. When you do a search, the results of the search
appear in a separate Album labeled Search Results (a
kind of temporary folder). The thumbnails resulting from
a search can be located in multiple folders (the image
file name is displayed at the top of the thumbnail and the
folder name is at the bottom).
The difference is one of orientation. Adobe is
strongly date-oriented because the Adobe designers
believe that most consumers know when they took a
photo, but not typically where it’s stored on the hard drive.
Jasc is strongly folder-oriented because that’s the traditional way of managing files on a PC. As a technical person, I like the folder orientation, but keeping track of where
everything is stored eventually becomes a nightmare.
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Creating a Slideshow from an Offline CD
Overall I think the Adobe approach is better, because they
really are right about date (time) being important, and
because it focuses on using (enhancing and sharing)
images rather than managing where they are.
Adobe’s date orientation is best illustrated by the
“Timeline” graphic that’s displayed across the top of
the screen. The timeline shows when the images in the
Photo Well were taken. The timeline is divided into
months and years; if you click on a month, the thumbnails in the Photo Well are scrolled so that they start
with the first photo taken that month. The timeline also
shows how images are distributed across time; the
height of the bar in each month is proportional to the
number of images taken in that month.

Proxy vs Direct Link
Thumbnail photos in Adobe are proxies for the actual
images, while thumbnail photos in Jasc are directly
linked to the actual image. This is a subtle but important
difference in the architecture of the two programs. As
an illustration of the difference, suppose that outside of
Adobe or Jasc you move an original image to a different
folder. In Jasc, the thumbnail simply disappears from
the Album view because the underlying image is no
longer in the folder. In Adobe, the thumbnail remains
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Above: Adobe PhotoWell
Below: Adobe Fix Photo

displayed in the Photo Well. When you click on the
thumbnail to display the image in Adobe, the following
message appears: “The source file for the item you’ve
selected to view cannot be found at the location stored
in the catalog. It may have been moved and/or renamed.
Please reconnect this catalog item to its source file.” A
browsing tool is then displayed to help you reconnect
the thumbnail and the original image.
The use of proxies in Adobe is driven by a philosophy of doing everything possible to preserve the original image. If something happens to an original image,
Adobe wants you to know about it and do something
about it. Jasc generally ignores the situation and lets
you manage it. For example, when you edit an original
image, Adobe puts up the following warning: “You are
about to edit an original photo; however, the original file
will not be changed. Your changes will be written to the

The following steps were used to create a
sideshow from images on an offline CD containing digitized film in three different resolutions (from PhotoWorks.com)
In Adobe Photoshop Album 1.0
■ Use the Get Photos from Files and Folders command on the File menu to bring a proxy of all the
images from the high-res directory on the CD into
the Photo Well.
■ Select the images to be used for the slide show.
■ Select Slideshow on the Creations menu. This
brings up a Workspace window containing small
thumbnails of the selected images. The order of
the images can be changed by drag-and-drop.
■ Right-click on each image and use the Find in
Photo Well command to select it for editing.
■ Make corrections to each image as needed
(rotate, crop, enhance, etc.). Photoshop Album
saves each edited image automatically in a folder specified in Preferences. The thumbnails in
the Workspace are updated automatically as you
edit the photos.
■ In the Workspace window, start the Creations
Wizard.
■ Select Slideshow as the desired output.
■ Select the slideshow style and settings (layout template, title page, background music, timing, transition, etc.).
■ Preview the slideshow to check that everything looks right.
■ Select the output media for the slideshow:
PDF file, burned to a CD, printed or attached to
an email.
■ Select the device, folder and file name where
the output will be written.
■ The finished creation is included in the Photo Well as a thumbnail. Select it and use the
Slideshow command on the View menu to view
the slideshow while in Photoshop Album. To
view the slideshow externally, open the PDF file
or insert the CD.

file: <FileName_edited.jpg>.” (This and other warnings
can be disabled if desired.) When you edit an original
image in Jasc, the original is overwritten with the edited version by default with no warning.
The use of proxies in Adobe also gives the program a performance advantage. Whenever you do a
search in Adobe, the resulting thumbnails display
instantly because no reference is being made to the
original image file. In Jasc, the thumbnails initially
appear as blank rectangles labeled “loading”; the
thumbnail images gradually appear as Jasc reads each
original image file. Most of the time the difference is
only a matter of a few seconds, but in some cases, the
difference is very noticeable. For example, displaying a
print preview of a 30-image contact sheet in Jasc can
take as long as 40 seconds. In Adobe, a contact sheet
print preview appears instantly.

Database
The database used to store catalog and other informa-

In Jasc Paint Shop Photo Album 4.0
■ Catalog the CD using the Catalog–CDROM command on the Tools menu. This displays thumbnails
of all the images on the CD as an Album.
■ Since the CD contained multiple copies of the
images at different resolutions, delete the duplicate thumbnails in the Album, making sure to
keep only the high-res images.
■ Select the images to be used for the slide show.
■ Use the Save a Slideshow command on the
Share menu to save the selected images and the
settings in a new directory on the hard drive.
Select the new directory in the directory tree
under the Browse tab to open a new Album
consisting of just the Slideshow images on the
hard drive.
■ Put the images in the desired order, either by
drag-and-drop, or by using the Sort Thumbnails
By command on the View menu.
■ Select all the images and make them writeable by using the Unlock command on the rightclick menu (the images are imported as readonly, since they were copied from a CD).
■ Make corrections to the images as needed
(rotate, crop, enhance, etc.), saving each image
over itself.
■ Select the slideshow settings (timing, transition, etc.) using the Slideshow Settings command
on the Share menu.
■ Select the Album background music using the
Album Soundtrack–Choose command on the Audio menu.
■ Save the finished slideshow using the Save
aSlideshow command on the Share menu again.
■ Use the View Slideshow command on the
Share menu to view the slideshow while in Photo Album. To view the slideshow externally, run
Player.exe in the folder above the one containing the slide show files.
■ To burn the slideshow to a CD, use third-party CD burner software. (Jasc supports burning
to CD, but while I was able to burn a Video CD, I
wasn’t able to burn a slideshow CD.)
tion in both programs is Microsoft Access, although neither database is designed for direct manipulation with
Access. While both programs provide a backup facility
for the database, there’s an important difference. Jasc’s
backup routine backs up only the database and no
images. You must manually archive images to back
them up. Adobe’s backup routine backs up both the
database and images, which is consistent with Adobe’s
“preservation” orientation. Jasc’s backup can be set to
run automatically after a certain number of exits;
Adobe’s backup can be run as a full or incremental
backup, which is a necessity because of the potential
size of the backup (Adobe’s help observes that “it’s best
to back up to a CD, DVD, or external hard drive”).
Actually, anyone who’s serious about backup probably already has a backup methodology in place, so neither program’s backup facility is that important. Possibly
more important is Adobe’s“Recovery utility which fixes a
“catalog damaged by a power failure or technical glitch.”
Jasc doesn’t have a database recovery utility.
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PHOTOSHOP ALBUM VS JASC PHOTO ALBUM

COMPARISON TABLE
FUNCTION/FEATURE
ADOBE PHOTOSHOP ALBUM 1.0 ASC PAINT SHOP PHOTO ALBUM 4.0
Organize & Find
Acquire images from
Camera (USB), card reader,
Camera (serial or USB), card reader,
scanner, files or folders on
scanner, any media (all files),
any media, WIA, TWAIN
Picture CD, FlashPath (SmartMedia),
WIA, TWAIN
Import images from other programs
Adobe PhotoDeluxe &ActiveShare No
Supported file types
.avi, .bmp, .gif, .jpg, .mov, .mp3,
.avi, .bmp, .dv, .flc, .fpx, .gif, .jpg, .jp2, .mov,
.mpg, .pdd, .pdf, .png, .psd, .sac,
.mp3, .mpg, .png, .psd, .psp, .qif, .sgi, .tga,
.tif, .wav
.tif, .wav
Catalog images on local or offline media Yes
Yes
Exclude files from catalog by size
Yes
No
Database backup
Catalog and images
Catalog only
Database archive/export
Yes
Yes
Database recovery utility
Yes
No
Specify default file save location
Yes
No
Sort by taken or last modified date
Yes
No (last modified date only)
Thumbnail display sizes
3
3
Modify top-level keywords/tags
No
Yes
Add multiple sub-levels of keywords/tags No
Yes
Time line/calendar of all images
Yes
No
History of image usage
Yes
No
Adjust image date and time
Yes
No
Display all metadata in image
Yes
No (only partial metadata)
Number of clicks for “Quick Fix”
5
1
Wizard for guided adjustment
No
Yes
Manual image adjustments
Crop, rotate, red-eye,
Crop, rotate, flip, red-eye, brightness,
brightness, contrast, fill-flash, contrast, fill-flash, backlight,
backlight, saturation
saturation, color balance, sharpness
Image view while making manual adjust. Choice of 4
Single small image
Zoom range
3% to 1600% in 8 steps
6% to 1600% in 10 steps
Set fixed aspect ratio during crop
Yes (9 choices)
Yes (12 choices)
Free-angle image rotation
No
Yes
Elliptical and freehand selection
No
Yes
Resize image pixel dimensions
No
Yes
Full-screen image view
Yes
Yes (only in slideshow)
Pen tool for image annotation
No
Yes
Embed text in image
No
Yes
Create panorama from multiple images No
Yes
Special effects
No
Yes
Add audio to image and/or project
Yes
Yes
Configurable Undo/Redo limit
No
Yes
Attach image to email
Yes (4 sizes, image/PDF)
Yes (original size or reduced)
Select email client to use
Yes
No (uses defaults email client)
Set images as screen saver/wallpaper Yes
Yes
Instant and/or structured slide shows
Yes
Yes
Create slideshow as PDF (single file)
Yes
No
Create standard web gallery
Yes
Yes
Create 3D web gallery
Yes
No
Includes FTP client to load web gallery No (“contact your ISP”)
Yes
Create Video CD (VCD)
Yes
Yes
Same VCD plays on DVD/computer CD No
Yes
Menu for multiple shows on VCD
No
Yes
Control burn speed, video format & copies No
Yes
Archive original images on VCD
No
Yes
Create formal photo album,
Yes (10 + 12 album styles,
No
greeting card, eCard or calendar
22 greet. card & eCard formats,
6 calendar styles)
Create QuickTime movie
Yes
Yes
New downloadable templates/formats Yes
No
Print sizes & combination layouts
23
40 + 28 Avery sizes
Presentation of finished project in catalog Yes
No
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External media
In Jasc, to display images located on the hard drive, you can click on the folder to
open an Album and browse the thumbnails. But if the images are located on an offline
CD that’s been cataloged, there’s no way to browse the catalog directly. The only way
to display the images is to do a search for them, using criteria such as the name of
the CD or a keyword/tag that you previously applied to all the images on the CD.
This contrasts with Adobe’s approach, where all thumbnails are equal.
Adobe stores all thumbnails, regardless of where they came from, in the catalog.
You can browse all the photos in the catalog by selecting the “Show All” button. Or
just like in Jasc, you can do a search for the images on a specific offline CD. In both
programs, clicking on a thumbnail of an image on an offline CD brings up a dialog
that asks you to insert the CD.
In general, Adobe does a better job than Jasc of handling external media. For
example, if you edit an image on a CD and then save the edited version, Jasc tries
to write the edited image back over the original on the CD — which of course it
can’t, because it’s a read-only media. Adobe not only won’t overwrite the original
(unless you ask it to), it also allows you to set a default folder for edited images, usually located on the hard drive. Consequently, editing an image on a CD is a smoother
process with Adobe.

Tagging images
The purpose of tags is to allow retrieving images by keywords. For example, if you
have photos of your pets stored in multiple folders on the hard drive (like I do), you can
tag them all, search for the tag, and have all the photos displayed in one place, regardless of their physical location. Both programs allow attaching multiple tags to an image
and/or a single tag to multiple images. However, they differ markedly in how much
freedom they give you to create tags. Adobe provides four tags at the highest level:
People, Places, Events and Other. You can’t rename them, delete them or add more.
All other tags must be in subcategories below the top four, and you can only have one
level of subcategories. The result is a very restrictive, flat structure.
Jasc, in contrast, allows complete freedom in the names and number of subcategory levels. Although Jasc also provides four starting tags at the highest level
(Location, Occasion, Photographer and Subject), they can be renamed or deleted.
The result is a very flexible tagging system that can be used to create a hierarchy
of any depth and complexity.

Searching for images
The two programs have fairly similar searching capabilities. However, Jasc can
search on a wider range of items, while Adobe does a better job of specifying the
search criteria. For example, Jasc’s date-range search allows “within 1 day to 6
months” of a given date, while Adobe’s date-range search allows entering two
actual dates. This means you can’t find “all images taken in 2002” (for example) in
Jasc without OR-ing two 6-month search windows.
The one search capability where Adobe significantly outpaces Jasc is in
searching image history (Jasc doesn’t even have the concept of image history).
Adobe can search for items that were:
✘ Imported from/date
✘ Received from/date
✘ Emailed to/date
✘ Printed on printer/date
✘ Exported to/date
✘ Ordered online from/date
✘ Shared online to/date
✘ Used in creation name/date
✘ Used in web gallery name/date
✘ Used in 3D web gallery name/date

Enhancing images
The image enhancement capability of these two programs is probably their least
important aspect because there are many programs that can enhance images.
Organizing and sharing images are activities for which there is much less existing
support software. A serious amateur photographer or photo hobbyist is likely to also
PRODUCT DETAILS
Operating system support
MSRP

Win 98SE, ME, 2000, XP
US$50 boxed or download

WEBSITE

www.adobe.com

Win 98SE, ME, NT4, 2000, XP
US$49 boxed, $45 download,
US$29 upgrade
www.jasc.com
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own Photoshop Elements or PaintShop Pro, either of
which are a much more powerful tool for image
enhancement. (Adobe expects >50% of Elements owners to purchase Album, and >20% of Album owners to
purchase Elements.)
That said, both programs are quite capable of
making basic image adjustments. There are three main
differences: the image view while making adjustments,
the cropping tool, and the availability of special effects.
In Adobe, there is choice of four image views while
making adjustments: the original image, the most
recently modified version (“before”), the current version (“after”), and side-by-side before and after images
–which is by far the most useful. The images are quite
large, about half of the screen height.
In contrast, Jasc provides only a single small
image (only one-quarter of the screen height), and the
image is split vertically into before and after. You look at
only the right half of the image to judge the enhancements — but what if the left half is the portion that most
needs enhancing? Unfortunately, the pan control can’t
be used while adjusting an image. Adjusting an image
in Jasc’s isn’t very satisfactory. On the other hand,
Jasc’s slider controls are much better than Adobe’s;
they have a clearly marked center point, eight clickable
gradations and a nice big slider.
The ideal cropping tool would be a blend of the
two programs. Jasc’s cropping tool makes a decent
educated guess at an initial crop and dims the remainder of the image, which is a helpful visual aid in cropping. However, the distance over which the cursor
becomes a two-headed arrow is extremely small (only
three or four pixels), so it’s quite difficult to grab one
side of the outline. Adobe’s cropping tool is an annoying, animated, dashed box, there’s no initial guess at a
crop, and the rest of the image isn’t dimmed. However,
the two-headed arrow remains on for 10-12 pixels,
which makes it very easy to grab one side of the outline.
I think Jasc includes special effects mainly as a
differentiator. In my opinion, none of the effects are
particularly effective except possibly some of the picture frames and the inversion/solarization. I find all the
distortion effects (e.g., glass blocks) to be just annoying, but perhaps that’s the technician in me speaking
rather than the artist.

Sharing
Both programs offer a substantial amount of capability
to share (publish) images. Adobe has more different
projects (formal photo albums, greeting cards, eCards,
calendars, etc.) but Jasc has more print sizes and combination layouts. Both can create an “instant” (selectand-show) slideshow and a more structured slideshow.
Only Adobe can publish the slideshow as a PDF, however, which can be a substantial advantage when distributing the slideshow.
Both programs can burn a slideshow with music
on a Video CD (VCD) that can be played on a living-room
DVD player, but there are some differences. Jasc wins
in this area by offering VCD menu capability, more control over the burning of the CD, and the ability to have a
single VCD work both in a DVD player and in a computer CD drive. Both programs can create a web gallery,
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Above: Jasc Album View ; Below: Jasc Video CD

but Jasc offers 40 background templates and 32 background textures, versus Adobe’s seven. On the other
hand, Adobe lets you build a 3D web gallery that’s quite
remarkable. In it, the images are displayed on the walls
of a virtual building or other structure. By manipulating
the cursor you can walk around the building, or you can
let Adobe give you a guided tour of the building. There
are 10 different virtual building styles (including
Stonehenge) with appropriate background music that
plays automatically. The 3D web gallery even includes a
Chat capability for conversing with other viewers of
your site.
The formal photo albums that Adobe can create
are handy, but limited because you can’t control the
layout page-by-page (it’s all automatically handled by
the program). The album templates also generally
expect standard aspect-ratio images, which I found to
be rather limiting, since I tend to crop my photos for
maximum visual impact rather than standard sizes.

Error messages
Adobe’s error messages tend to be more detailed and
thorough than Jasc’s. Suppose you want to rotate and
save an image whose pixel dimensions are not a multiple
of 8 or 16. Jasc lets you rotate and save it without warning, but Adobe puts up the following message: “The
photo <FileName> cannot be rotated losslessly and written back to the original file. Reason: Lossless rotation of
JPEG files is only possible when the image dimensions
are multiples of certain sizes. An edited copy will be created for the rotated photo.” Again, Adobe tries very hard
to preserve your original image.
Jasc’s error messages are sometimes an oversimplified version of Paint Shop Pro’s error message.
For example, if you try to modify a locked (read-only) file
on the hard drive, Jasc’s error message is only “Error
writing to <FileName>”, while Paint Shop Pro’s error
message in the same situation is “Cannot save
<FileName>. The file exists and is read-only.”

User interface details
Both programs are standard Windows applications, so
they’re both relatively easy to use. However, I found
some minor differences between them that had some

Geoff Walker is a writer, mobile-computing consultant (www.walkermobile.com) and amateur photographer living in Silicon Valley. Geoff is also the Technology Editor of Pen Computing, our sister publication.
He can be reached at geoff.walker@att.net.

effect on the overall ease of use. Adobe is the more
“standard” of the two. For example, to go from one
mode to the previous mode (e.g., from the Image View
screen back to the thumbnail screen), Adobe uses a
“Back” button – just like a browser. Jasc puts a
“Close” button in the middle of the toolbar at the top of
each screen. Because of years of browser use, I find
using the Back button more intuitive.
Adobe also makes more use of the right-click
context menu, which I like because it reduces mouse
movement. In Image View in Adobe there are 21 distinct
functions on the right-click menu; Jasc has only 10. In
Jasc, some functions are closed via a standard Close
control (such as the Make Movie dialog), others use a
toggle (such as all the tabs along the left side of the
screen), and still others (such as the Pen Tool) can only
be closed by selecting a different tool (such as Zoom or
Pan). More consistency would make Jasc easier to use.
Help is an order of magnitude better in Adobe.
The Product Overview is a real movie, rather than slides
with animated text like in Jasc. The help system is
browser-based, and it contains a full user guide with a
good index. Adobe’s help contains many suggestions,
hints and tips, as does the program itself. Unfortunately,
the program doesn’t come with a printed User’s Guide,
only a Getting Started manual — which at least provides
a decent introduction.
Jasc’s help system uses the standard Windows
application help engine; the content is a basic series of
“how to” procedures — some of which are missing, for
example, the procedure to create a VCD menu. The
same content is provided in the box as a printed User’s
Guide, but it’s not any better in print. There are no tips,
suggestions or error message translations. The index is
weak; there isn’t even an entry for “search”, which is
one of the four big tabs on the left side of the screen!
There’s also no entry for “unlock” (or “lock”), which you
need to know about in order to unlock files imported
from a CD. Adobe wins this part of the contest by a mile.
Support for the product on the Jasc website is
poor, where the Knowledge Base is empty. Support on
the Adobe website is a little better, where there is at
least a decent set of 67 FAQs and a good user-to-user
Forum — although the Adobe Knowledge Base is also
empty. Once the programs have been on the market for
a few months, the support on both websites should
improve substantially.

And the winner is...
After using both programs over a period of a month, I
could live with either one. They both do a better job of
organizing and sharing images than anything else I’ve
ever seen. But my favorite is Adobe, because of the following features:
✘ Proxy architecture ✘ Selective cataloging
✘ Timeline
✘ Image history
✘ PDF output
✘ Excellent help
✘ Wide range of projects for sharing
✘ Side-by-side image view for adjustments
✘ 3D web gallery
For US$49 or US$50 for the boxed product (US$45
for a Jasc download), both programs offer a terrific
amount of capability. –Geoff Walker

April/May 2003 DIGITAL CAMERA MAGAZINE 25

